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Software Product License Agreement 
and Limited Warranty

Please carefully read this License Agreement before proceeding to operate this equipment.
Rights in the software are offered only on the condition that the Customer agrees to all terms
and conditions of the License Agreement. Proceeding to operate the equipment indicates your
acceptance of these terms and conditions. If you do not agree to the License Agreement, you
must now either remove the software from your hard disk drive and destroy the master
diskettes, or return the complete software package to your dealer or Hewlett-Packard (HP).

Software License Agreement

The software is a product of EuroForm ApS © 1995 (EuroForm). The Customer is granted a license in
the software, subject to the following:

● Customer may use the software without time limit on one computer to manage one printer. Customer
may not reverse assemble or decompile the software.

● A separate license agreement and fee is required for each additional computer on which the product 
is used and for any second and subsequent printers managed by that computer.

● The software may not be duplicated or copied except for archive purposes, program error 
verification, or to replace defective media, and all copies must bear the copyright notices contained 
in the original.

● This license and the software product may be transferred to a third party, with written prior consent 
from Hewlett-Packard, provided the third party agrees to all the terms of this License Agreement and
the Customer does not retain any copies of the software product.

● Acceptance of this license does not transfer any right, title or interest in the software product to the 
Customer except as specifically set forth in this License Agreement. Customer is on notice that the 
software product is protected under the copyright laws. This software product may have been 
developed by an independent third party software supplier named in this package, which holds 
copyright or other proprietary rights to the software product. Customer may be held responsible by 
this supplier for any infringement of such rights by the Customer.

● EuroForm reserves the right to terminate this license upon breach. In the event of termination, 
Customer will either return all copies of the product or, with prior consent, provide a certificate of 
destruction of all copies.

● In the event Customer modifies the software product or includes it in any other software program, 
upon termination of this license Customer agrees to remove the software product or any portion 
thereof from the modified program and return it or to provide a certificate of destruction thereof.
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Software Product Limited Warranty

One-Year Limited Software Warranty
HP warrants for a period of ONE YEAR from the date of the purchase that the software product will
execute its programming instructions when all files are properly installed on the personal computer or
workstation indicated on the package. HP does not warrant that the operation of the software will be
uninterrupted or error free. In the event that this software product fails to execute its programming
instructions during the warranty period, Customer’s remedy shall be to return the diskette(s) (‘media’)
for replacement.

Media 
HP warrants the media upon which this product is recorded to be free from defects in materials and
workmanship under normal use for a period of ONE YEAR from the date of purchase. In the event the
media proves to be defective during the warranty period, Customer’s remedy shall be to return the
media for replacement. 

Notice of Warranty Claims
Customer shall notify Vendor in writing of any warranty claim not later than THIRTY (30) DAYS after the
expiration of the warranty period.

Limitation of Warranty
HP makes no other express warranty, whether written or oral with respect to this product. Any
implied warranty of merchantability or fitness for a particular purpose is limited to the one year
duration of this written warranty. Some states or provinces do not allow limitations on how long
an implied warranty lasts, so the above limitation or exclusion may not apply to you. UK ONLY:
If you are a ‘consumer’ as defined by statutes, parts of this statement may not apply to you.

This warranty gives specific legal rights, and you may also have other rights which vary from
state to state or province to province.

Limitation of Liability and Remedies
The remedies provided above are Customer’s sole and exclusive remedies. In no event shall HP
be liable for any direct, indirect, special, incidental or consequential damages (including lost
profit) whether based on warranty, contract, tort or any other legal theory. Some states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

Bulletin Board
A bulletin board service is available through contacting http://www.hp.com/go/cposupport

Alternatively contact your nearest Hewlett-Packard LaserJet Customer Support Centre :
USA  +1 208 323 2551
Europe  +31 206 828 291
Asia-Pacific  +61 3 9272 8000
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Notice

The information contained in this document is subject to change
without notice.

Hewlett-Packard (HP) makes no warranty of any kind with regard to
this material, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose.

HP shall not be liable for errors contained herein or for incidental or
consequential damages in connection with the furnishings,
performance, or use of this material.

HP assumes no responsibility for the use or reliability of its software
on equipment that is not furnished by HP.

This document contains proprietary information which is protected
by copyright. All rights reserved. No part of this document may be
photocopied, reproduced, or translated to another program language
without the prior written consent of Hewlett-Packard Company.

Microsoft®, Microsoft Windows™, Windows 95™ and Windows NT™

are US registered trademarks of Microsoft Corporation.

All other company and/or product names are trademarks or
registered trademarks of their respective companies.

© Hewlett-Packard Co. 1996. All rights reserved.

Printed in the UK
September 1996
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1.1  Introduction
HP Flash SIMM and HP hard disk drives are non-volatile, 
re-programmable memory options for HP LaserJet Printers. In this
manual these will be referred to as Non-Volatile Memory (NVM).

Non-Volatile Memory, or NVM, can be used to store macros, forms,
fonts and signatures created specifically for use in a customised
environment which will remain stored even when the printer is
turned off.

1.2 Benefits
Among the benefits of using NVM are:

● Increased Throughput 
As commonly used forms, fonts and signatures are stored in the 
printer, the volume of data transmitted to the printer and hence
the time taken to download a job can be significantly reduced, 
resulting in faster overall printing times. The corresponding 
reduction in network traffic will help avoid network congestion.

● Improved Document Management
More effective electronic document management through 
password protection, network download and update of company 
standard documents, provides a secure and easily managed 
printing environment.

● Cost Savings
A reduction in stationery costs is achieved by the effective 
implementation of electronic documents, reducing the need for 
pre-printed stationery.

● Better Mixed Language Printing
Conflicts between PCL and Postscript print jobs are reduced 
when operating in a mixed printing language environment. PCL
data stored in the NVM is not overwritten when the 
printer switches languages.

● Improved Printer Control
Printers on the network can be accessed using bidirectional 
communications allowing the status and contents of the NVM to
be remotely interrogated and managed.

1. Introduction 
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1.3 Compatibility Matrix

Note: Not for use with HP LaserJet 4L, 4ML, 5L, 5ML, 5MP

1.4 System Requirements
●IBM or 100% compatible  286, 386, 486 or Pentium PC or PS/2 computer
●8 Mb available disk space
●MS-DOS version 3.1 or higher
●Microsoft Windows 3.1 or higher or Windows 95, Windows NT or Win OS2

Note: When using Windows NT or Win OS2, the software operates in Windows 3.1,
or higher emulation mode.

Network Requirements (for NVM use in a networked printer)
●HP JetDirect interface card with firmware rev. A.03.15 or higher installed in printer
●If using Novell Netware, it must be v3.11 or above with ODI or VLM workstation shell

Requirements for Network BiDi communications
●TCP/IP protocol enabled on the HP JetDirect card (Refer to the HP JetDirect 

manual for instructions).
●Windows Sockets v1.1 compliant TCP/IP stack running on a PC 

(e.g. Novell LanWorkPlace or Lan WorkGroup)

Warning: Bi-Di communication from Windows NT client workstations is not supported
in this software revision.

Note: Information in this document is subject to change without notice.

Printer Type/Product 1Mb 2Mb 4Mb 420Mb
SIMM SIMM SIMM Disk 

HP LaserJet 4/4M C4025A C4025B C4025C -

HP LaserJet 4+/4M+ C4025A C4025B C4025C -

HP LaserJet 4P/4MP C4025A C4025B C4025C -

HP LaserJet 4V/4MV C4025A C4025B C4025C -

HP LaserJet 4Si/4Si MX C4025A C4025B C4025C -

HP LaserJet 5P B1378A B1379A B1380A -

HP LaserJet 5/5N/5M - C3930A C3931A -

HP LaserJet 5Si/5Si MX B1375A B1376A B1377A C2965A

HP LaserJet 6P/6MP B1387A B1388A B1389A -
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2.1 Installing an HP Hard Disk
Refer to C2965-90001 manual shipped with the HP hard disk sub-
system for installation instructions.

2.2 Installing an HP Flash SIMM
Check the HP Flash SIMM against the compatibility matrix on the
previous page to ensure it is the correct unit for the printer
concerned.

For information on how to install the HP Flash SIMM board in the
printer, please refer to the section entitled ‘SIMM board installation’
in the printer's User Reference Manual and Figure 2.1 below.

Figure 2.1 Installing the HP Flash SIMM

WARNING SIMM boards can be easily damaged by small amounts of
static electricity. To reduce the risk of damage, keep the 
SIMM in its anti-static bag until ready to install. Touch 
something metal before the card and handle the board 
carefully at all times, avoiding flexing it or touching its 
components.

2.  Installation 

1 2
30˚
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HP LaserJet 4P / 4MP
Prior to installation in the HP LaserJet 4P and 4MP, remove the
blue jumper located on the SIMM board. For other printers the
jumper must be left attached.

Resource Saving Considerations (HP LaserJet 4Si / 4V / 4Plus)
On the HP LaserJet 4Si printer, Resource Saving should be disabled.
It is possible to operate with Resource Saving enabled but then it is
necessary to switch the power OFF and then ON again, after
downloading, for the HP Flash SIMM to work correctly.

On the HP LaserJet 4Plus and the HP LaserJet 4V printers,
Resource Saving can be enabled but it will be disabled automatically
by the installation of the HP Flash SIMM. 

The following table shows hardware specific settings for the 
HP LaserJet family. 

Printer Type Jumper Setting Recommended Resource
on SIMM Saving Setting

HP LaserJet 4P/4MP OFF n/a

HP LaserJet 4Plus/4MPlus ON ON (S/W controlled)

HP LaserJet 4/4M ON n/a

HP LaserJet 4Si/4Si MX ON OFF

HP LaserJet 4V/4MV ON ON (S/W controlled)

HP LaserJet 5P ON ON (S/W controlled)

HP LaserJet 5Si / 5Si MX ON ON (S/W controlled)

HP LaserJet 5 / 5N / 5M na ON

HP LaserJet 6 ON ON
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Testing the Installation
To test that the HP Flash SIMM is properly installed, do the
following:

● Turn the printer ON
● From the printer Control Panel, take the printer offline by 

pressing the Online key
● Use the Menu key to select the Test Menu
● In the test menu, scroll to the Flash SIMM Page using the 

Item key
● Press the Enter key

Note: On the HP LaserJet 5P and 5Si it is not possible to print a
status page from the printer’s front panel. A status page can be
printed using the HP Forms and Font Manager software included
with the HP Flash SIMM.

If installation is successful, the display will indicate ‘FLASH PAGE’
and the printer will print an HP Flash SIMM Status Page. If the
printer does not have a front panel display, the printer will just print
the status page. If this fails, check you have followed the installation
instructions correctly and that the HP Flash SIMM board is correctly
seated in the SIMM slot.

2.3 Installing the HP Forms and Font Manager software
Accompanying the Non-Volatile Memory (NVM) is a software
program called HP Forms and Font Manager. Its purpose is to
manage the selection of macros, forms, fonts and signatures. It also
manages the process of downloading to a printer and the contents
and status of the NVM. 
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To install the software, do the following: 

● Insert the diskette labelled ‘HP Forms and Font Manager 
Disk 1’ in drive A:

● In Windows, from the Windows Program Manager choose 
File/Run

● In Windows 95, chose Start then Run from the TaskBar
● Type A:\SETUP (or specify the letter of the drive containing the

installation diskette) in the text box
● Click Next to continue
● Follow the instuctions on the screen, clicking Next to select the 

recommended system defaults
● When Setup has finished working the message ‘Installation 

Completed Successfully’ will be displayed. The README file 
can be reviewed at this point or later using Notepad or another 
text processing program.

● Remove the diskette from drive A. Installation is now complete.

To use the HP Forms and Font Manager in a network environment,
the Network Operating System must be Windows Sockets v.1.1
compliant. The networked printers must have TCP/IP enabled on the
HP JetDirect cards and IP addresses set (Refer to the HP JetDirect
manual, P/N J2552-90051, for instructions).
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3. Getting Started

Once the NVM is installed in the printer and the HP Forms and Font
Manager software is installed on the PC, load the program by double-
clicking on the icon in Program Manager. The HP Forms and Font
Manager main screen will appear with the following icons in the
toolbar.

Toolbar Summary
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Icon Description

New Project

Open Project

Save Project

Download Project 

Print Status Page 

Project Contents

Test print selected files

NVM – Remove file

Sort Ascending

Sort Descending

Enable BiDi

Display BiDi information

Autonumber

Add or Remove file from Project
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3.1 Selecting a Printer
From the File Menu choose Printer Select

Figure 3.1  Printer Selection

From the drop down list, select the printer to be used. If it is a
network printer, select it by its name and IP address, not by the port
connection. If the printer is directly connected to your PC then select
the printer driver and the port connection. Highlight the printer,
click on Select, then click on OK.

3.2 Defining the Environment Parameters
From the Options Menu choose Environment. Select and modify
parameters in each of the four tabbed sections as detailed below. Do
NOT click on OK until all sections are completed as this will exit the
Environment screen.

Figure 3.2  Environment /Password Screen
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signatures which are stored in the NVM, a password must be set.
Click on the Password tab and enter a password in the Current
Password box and in the New Password box then click on the
Paths & Files tab. Do NOT click OK.

Figure 3.3  Environment/Paths & Files Screen

Click on the Paths & files tab. This screen is used to set the file
storage location and how the files are processed. Initially, only
specify the directory to be used to store the download files created.
The default of C:\FLASH\DATA can be accepted.  (For information
on the other parameters refer to Section 4.1.1.2 in this manual). Click
on the BiDi tab. Do NOT click on OK.

Figure 3.4 Environment/BiDi Screen
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The printer displayed in the Current Printer box should be the one
selected from the Printer Select list box shown in 3.1. Put a check
mark in the Check Printer for BiDi box then click on Test Now.
After a couple of seconds, 00 READY should appear in the message
box and also be displayed in the bottom right hand corner of the
Flash SIMM Manager window. (Note: The selected printer must
support BiDirectional communication. If it does not, this facility will
not operate. Refer to Section 7: Glossary for more information).

Figure 3.5  Environment/Product Screen

Click on the Product tab. This screen is used to choose the non-
volatile storage product available in the selected printer. If BiDi is
enabled, this will be automatically detected. If BiDi is not enabled,
click on the non-volatile Storage product and Printer language
required.

Now all four sections have been completed, click on OK. A pop-up
message box will appear saying ‘Password has changed. Update
now?’ Click on OK. The password will be downloaded and set for the
NVM. The other settings will also be saved.
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3.3 Configuring Network Printers
If there are network printers with NVM installed in them, choose
Network Setup from the Options Menu. (If there are no network
printers go to Section 3.4).

Figure 3.6  Network Printer Configuration

Add each network printer to the list in this screen, together with its
IP address. (Your Network Administrator should be able to supply
the IP addresses). Click on the Add button, type the printer’s name
and address in the dialog box and, when all the printers have been
added, click on OK. The list may be edited later if necessary.

3.4 Downloading and Printing Examples

Figure 3.7  HP Forms and Font Manager Main Screen

To download and print an example form, font and signature, follow
the instructions below.
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Note: Not all printers support all software functions. Functions not
supported by particular printers will be ‘grayed’ out and not available
for selection.

Figure 3.8  Open Project Window

● Click on File
● Select Open Project. The following screen will appear.
● Select demo.prj from the Select filename box. Click OK. 
● Click on the [PRINT ICON] icon in the tool bar at the top of the 

main screen.
● The following dialog box will the appear and should identify the 

default printer with the NVM installed. Click OK. 

Figure 3.9  Print Dialog Window
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The example form, font and signature will be downloaded to the
NVM in the default printer. To print either the example form, font or
signature, highlight the appropriate file in the main screen Project
Contents box (See Figure 3.7) and click on the icon.

If the project has been downloaded successfully, the lights on the
right hand side of the screen will turn green.

3.5 Defining Project Defaults

From the Options menu, choose Project Defaults. Select and
modify parameters in the tabbed sections as detailed below. Do NOT
click on OK until all sections are completed as this will exit the
Project settings screen.

Figure 3.10 Project settings/Printer Codes Screen

Click on the Printer codes tab. This screen is used to select the
default treatment of codes which control the mechanical functions of
the printer. If the boxes are not checked then click on Select All. Do
NOT click on OK
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Figure 3.11 Project settings/Optimize Screen

Click on the Optimize tab. This screen is used to select whether or
not bitmaps should be compressed. For now, make sure there is a
check mark in the Optimize box. Do NOT click on OK.

Figure 3.12 Project settings/Test print Screen

Click on the Test print tab. Select Portrait or Landscape
orientation to suit the orientation of the macro. In the Test text box
type some text to appear on test prints.  In the boxes below choose
the units of measurement to work in, and set the X and Y co-
ordinates for the location on the page for test macros to be printed.
Do NOT click on OK.
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Figure 3.13 Project settings/Bitmap Conversion Screen

Click on the Bitmap tab and then on the Convert bitmap tab. This
screen selects the type of conversion that will be applied to bitmaps.
Select ‘To macro’ , the program defaults to ‘To Font’. To remove the
white space around the edges of all bitmaps put a checkmark in the
box.  To invert all bitmaps (i.e. have them print in negative) put a
checkmark in the box. These settings can be changed for individual
bitmaps later. Do NOT click on OK.

Figure 3.14 Project settings/Bitmap/Macro Screen
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Click on the Macro tab. Leave the ID as zero, set the resolution to
match the selected printer and set the units of measurement.  The X
and Y default co-ordinates can be set here.  These are relative to the
last cursor position, unless the Absolute box is checked.  For now
leave the co-ordinates at zero and the Absolute box unchecked.  

Once the above sections have been completed, click on OK. The main
screen will re-appear.

3.6 Assembling the Project

Figure 3.15 Main Screen/New Project

Click on the icon (or select View/Select Directory) to select
the directory which contains the files to be included in the Project.
Select the files required and either drag and drop them into the
Project Contents window or click on the arrow button to transfer
them across.
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Figure 3.16 Main Screen/ Project Contents

Allocate an ID number to each macro in the Project. Highlight the
ID column and use the Autonumber button at the far right of the
button bar to allocate numbers automatically. A description can be
entered for each file. 

3.7 Saving the New Project
From the File Menu choose Save Project As.

Figure 3.17 Saving a Project

Give the Project a name and, optionally, a description to help
identification. Change the directory if necessary. Then click on OK.
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3.8 Download the Project to the NVM
From the Main Screen, select Run and then select Download to
the Printer.

Figure 3.18 Output Selection Screen

Select Output to the printer. It is also possible to select output to a
file for later downloading to several printers at once. Click on OK. A
progress screen will be displayed.

If the download has been successful (and provided that BiDi is
enabled) a green bar will be displayed by each file in the Project.  A
test print of each file in the Project can now be produced. Highlight a
file and click on the Test print button in the button bar. The NVM
can be checked using the BiDi facility (if available). Click on the
BiDi Information icon in the tool bar to see the contents of the NVM.

Figure 3.19 BiDi Information Screen



23

4.1 Setting up the HP Forms and Font Manager
Having followed the steps in the Getting Started section, the HP
Forms and Font Manager will be configured and running.

4.2 Defining Your Environment
The first step in creating a new Project is to configure the
environment in which the project will operate. From the Options
Menu, select Environment to display the environment screen.
(shown in Figures 3.6, 3.7 and 3.8 in the Getting Started Section).

4.2.1 Password
The Password panel allows a new password to be set or an existing
password to be modified or deleted. This panel can be used on its own
or in conjunction with a Project. (Instructions for setting a password
on a new NVM module are in the Getting Started section).

To change the password on an NVM module that is already password
protected, do the following:

● Select Options/Environment
● Type the current password in the Current Password box.
● Type the new password into the New Password panel. Select 

OK. A dialog box will appear with ‘Password is changed. 
Update now?’ displayed. Click on Yes.

● The password will be downloaded to the NVM and
‘NVM Open’ will be briefly displayed on the printer's front panel

● When the download is complete, ‘Ready’ will appear on the 
printer's front panel.

● To download a macro and/or font with password protection, the 
password in the Current Password box must be the one set on 
the NVM and the Password box must be checked in the 
File Properties screen

4. Managing the NVM
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To delete a password from the NVM do the following:

● Select Options/Environment
● Type the current password into the Current Password box
● Leave the New Password field blank and check the Clear 

Password box
● Select OK. A dialog box will appear with ‘Password is 

changed. Update now?’ displayed. Click on Yes.
● The password deletion will be downloaded. ‘NVM Open’ will be 

briefly displayed on the printer's front panel.

● When the update is complete ‘Ready’ will appear on the 
printer's front panel.

● To verify that the password has been disabled, either click on 
the Status Page button to print a status page or click on the 
BiDi Info button to see the status on screen.

Remember: if the password is deleted, none of the macros, forms,
fonts or signatures in the NVM will be password protected.  If the
password is forgotten the NVM will have to be re-initialised, which
will erase all data stored in it.

4.2.2 Paths and Files
The paths option allows the path to the directory in which the
download files should be saved to be specified.  A backup of the
existing download file can be created each time a new one (the .ALL
file) is saved if the Make .BAK file option is checked. If it is not
checked a backup file will not be created. 

If the .ALL files are to be stored in hexadecimal format (typically for
use in environments that support only 7-bit ASCII) a check mark
should be put in the Hex Format box.

4.2.3  BiDi
BiDi must be enabled in the Environment/BiDi screen (See Figure
3.5 in the Getting Started section) to allow BiDi communications with
any printer on the network without interrupting print jobs.

This option allows monitoring of the status of the selected printer by
displaying messages from its front panel on your computer screen.  
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Choose the printer to be monitored from the File/Printer Select
menu in the HP Forms and Fonts Manager Main Screen. Highlight
the required printer from the drop down list box and click on Select.  

Check the Check Printer for BiDi box then click the Test Now
button. The printer front panel message should be appear in the box
below. When working on a Project the front panel messages will be
displayed at the right hand end of the tool bar. If Check printer for
BiDi is not selected the HP Forms and Font Manager will not
monitor BiDi signals from any printer. This setting controls the
action of the BiDi Connect button.

Note: If the PC is connected to a network and has a local printer
physically connected to LPT1, be aware that selecting the printer on
LPT1 in the Printer Select box enables BiDi communication with the
physically connected printer. If network printer redirection of LPT1 is
enabled to allow printing to a printer on the network, data will be
downloaded to the network printer even though the BiDi
communication is with the local printer. Be particularly careful of
this when using General Updates functions.

4.3 Setting Project Defaults and Using the Advanced Options
The Project defaults will affect all of the files in the Project. If
necessary, they can be over-ridden on a file-by-file basis, using
Advanced Options which can be accessed by clicking on the Red A to
the right of the file name in the Projects Contents window of the
Main Screen. Some of the settings are file specific and screens which
control these are not available when setting Project Defaults.
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4.3.1 File Properties

Figure 4.1 Advanced Options/File Properties Screen

This screen is available in the Advanced Options set only.  It shows
information about the selected file. The description field allows text
to be entered to help identify the file. The file type is determined  by
the HP Forms and Font Manager by examining the contents of the
file. If the file type is incorrect, it can be altered by selecting the
correct file type from the drop down list box. If the macro is to be
password protected, check the Password box.  

The lower part of the screen allows the name of the source file from
which the macro was made to be entered, so that it can be edited if
required.  If the source file is to be edited, click on the Run button to
launch the associated application. (This feature relies on the
associations set up in the Extensions section of the WIN.INI file).
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4.3.2 Font Information

Figure 4.2 Advanced Options/Font Information Screen

This screen is only available from the Advanced Options set and
gives detailed information about the selected font. There are no
settings here to configure. For an in-depth explanation of PCL font
characteristics please refer to the Hewlett-Packard PCL5 Printer
Language Technical Reference Manual (HP Part Nº. 5961-0509).

4.3.3 Printer Code Exclusion
The Printer Code Exclusion panel allows the selection of escape
sequences and printer commands to be excluded from the files added
to the project. 

Most applications will insert printer commands when creating
output files. These commands may not be required when using the
file as a macro. (e.g. an invoice template should not print and
formfeed before the invoice data has been merged). 

The default is to strip all the codes which control the mechanical
functions of the printer. These codes are listed in the panel. Any
necessary control codes can then be inserted at the right place in the
Project using the Job Command functions (see below). This panel is
also available in the Advanced Options set, to allow the default
settings for individual files to be over-ridden.
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4.3.4 Job Commands

Figure 4.3 Advanced Options/Job Commands Screen

This is accessed through selecting Options/Project/Defaults. Select
those printer control commands from the list of Available Commands
that should be issued before or after the file. (e.g. a Form Feed
command may be required before printing a letterhead macro to
ensure that it is always printed at the top of a new page). The order
of commands can be re-arranged by highlighting one and then
clicking on the Up and Down arrows at the side of the Selected Job
Commands window to move it relative to the others. Commands can
be included which are not predefined in the list of Available Commands
by selecting Use Escape and supplying your own parameters.  

The ability to send printer control commands before and after macros
allows the construction of complex print jobs which are then very
simple to use.
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4.3.5 Optimize

Figure 4.4 Optimization Screen

Optimization uses a compression algorithm to minimise the amount
of storage space taken up on the NVM. The default is to optimize all
files. If Optimize bitmaps is deselected, any bitmap files in the
Project will not be compressed. This panel is also available in the
Advanced Options set, and can be used to calculate the the amount of
space saved by compressing the file, as well as the time taken to
carry out the compression.

4.3.6 Bitmap

4.3.6.1 Convert Bitmap
This panel is used to define how the NVM will handle the conversion
of bitmap files. The HP Forms and Font Manager can convert a
bitmap to either a macro file or a font. Generally the default should
be set to macro. Use conversion to a font when processing bitmaps
to be included in a text stream (e.g. scanned signature bitmaps).

When a bitmap is saved there will probably be white space saved
around the edge of the graphic. If the white space is not required
select Remove White Space. Any extraneous white space will be
stripped, which will save memory in the NVM.  
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If the graphic is black on white but a negative image is required
(white on black), check the Invert Picture box. If the graphic is
inverted, the white space around it becomes black. This should be
taken into consideration when deciding whether or not to select
Remove White Space. 

4.3.6.2 Font

Figure 4.5 Advanced Options/Font Definition Screen

Advanced Options only: If bitmap To font conversion is chosen it
will be necessary to assign a typeface ID number to the font. There
may already be soft fonts stored in the printer's memory, and each of
these fonts has an ID number. A listing of these can be obtained
(Refer to the printer’s User’s Reference Manual). The ID number
allocated here should be different from those already in the printer
(otherwise an existing font will be over-written).  Enter the two
character code for the symbol set required (Refer to the HP PCL
Technical Reference Guide, P/N 5961-0509, for a list of the Printer
Commands for selecting symbol sets), give the font a name (up to 16
characters) and then select which letter will be used to call the
bitmap. The ID at the bottom is the Font ID number assigned in the
Project Window.  
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4.3.6.3 Macro

Figure 4.6 Macro Definition Screen

This screen is used to set the printing resolution for graphics and the
co-ordinates for positioning the graphic on the page. 

The Units list box allows the selection the units of measurement.
The co-ordinates given will be measured relative to the last cursor
position, which is where the preceding text stops. If an exact position
on the page needs to be specified, check the Absolute box. The co-
ordinates given will then be measured from the top left hand corner
of the printable area of the page. (Refer to the PCL 5 Printer
Language Technical Reference Manual part No. 5961-0509 for
information on the printable area of the page).

In the Advanced Options set the Macro ID number assigned in the
Project Window will be seen. Any of the default settings can be over-
ridden.

4.3.6.4 Test Print Position
This screen is used to set the page orientation and the position on the
page of test prints.  As in the previous screen, select the units of
measure from the Measures list box and then enter the co-ordinates
for the placement of the test print. The co-ordinates are measured
from the top left hand corner of the printable area of the page. 
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4.4 Creating a New Project
Now that the Environment settings and Project Defaults have been
configured, a new Project can be created.

4.4.1 Selecting Files for Inclusion
Select the files to be added to the Project from the list box on the left
hand side of the Main Screen (see Figures 3.11 and 3.12). The four
buttons across the bottom of the list box allow the selection of the file
types to be displayed by clicking on one or more buttons. 

The following can be selected:

font files, macros, bitmap files, or all files.

Use the left-most  button to select the drive and directory which
contains the files to be included. By default, the FLASH/DATA sub-
directory is shown. The files will be listed with an icon identifying the
file type beside the name. Any bitmaps in an unsupported format will
be indentified in the listing with a red cross over the bitmap icon. 

4.4.2 Assembling the Project
Click the mouse on the file to be included in the Project to highlight
it.  Multiple file selection follows normal Windows conventions using
the Shift key (sequential) and the Ctrl key (non- sequential).  Now
either drag the files over to the Project Contents window and drop
them in, or double click on the highlighted area, or click on the arrow
to transfer it.  

In the Project Window, select each file in turn and assign it a unique
ID number, files cannot be downloaded without one. Click on the ID
field to the right of the file name and type in a number. ID numbers
must be in the range 1 to 32767 (excluding the reserved range 31100 to
31400). 

If there are several files in the Project and sequential ID numbers are
to be used, only the first one need be entered. The rest can be
numbered automatically by choosing View/Autonumber from the
menu bar or clicking on the Autonumber button.  When all the
required files have been gathered into the Project Contents window
and IDs assigned to each the Project should be saved.
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4.4.3 Saving the Project
Click on the Save Project button in the toolbar or select File/Save
from the Menu bar. A dialog box will appear prompting for a Project
name.  Enter the Project name and optionally a brief description to
help later Project identification. Click on OK.

The file will automatically be given the extension .PRJ and be saved
into the \PROJECTS subdirectory. 

4.4.4 Printing a Project list
A Project list can be printed which will show general information
about the Project, information on the default settings, and all the
fonts and macros included in the Project, along with the ID number
for each one. To print this list either click on the Print Project List
button in the toolbar, or select Options/Documentation/Print
Project List from the menu bar. The Project must be open.

4.5 Working on an existing Project
Select Open Project in the File Menu or click on the Open Project
button in the toolbar. An Open Project window will appear showing
all Projects saved in the Projects subdirectory. (A different drive and
directory can be selected if the required file is saved elsewhere.)

Select the Project to work on by clicking the mouse on the Project
name to highlight it. It will appear in the Project field, along with a
description if one has been entered. Click on OK.

The macros and font files contained in the Project will appear in the
Project Window. Files can be deleted from the Project (highlight them
using the arrow keys and then press the Delete key) or added (by
copying them from the file list box on the left). Files may also be
marked for deletion from the NVM (select the file and click on the
Remove file button in the tool bar). If necessary, alter the
configuration parameters of any file by clicking on the red A to the
right of the file name to access the Advanced Options.

Files can be moved from one project to another by Drag and Drop.

E
n

g
lis

h



34

When working with the selected Project is finished, click the mouse
on the Save Project button or select Save Project from the File
Menu.  If the modified Project is to be saved as a different file, select
Save Project As from the File Menu. A dialog box will appear
prompting for a new Project name. Type a name in the box and,
optionally, enter a description in the box below. Click on OK.

4.6 Downloading Data to the NVM

4.6.1 Download to one printer
Once a Project has been saved, click on the Printer button or select
Download to the Printer from the Run menu. A window will
appear asking where the output should be sent. The options are:

● Send it directly to the printer (a batch download file, using the 
same name but with the extension .ALL, will be automatically 
be saved into the FLASH\DATA subdirectory). 

● Create a batch download file with the extension .ALL

Select Output to selected printer. ‘NVM Open’ will be briefly
displayed on the printer's front panel as the data is transferred into
the NVM. Then, when the update is complete, ‘READY’ will appear
on the printer's front panel. If BiDi is enabled these printer messages
will appear in the right hand end of the tool bar.

4.6.2 Test Print
Having assembled the Project and downloaded it, any of the files can
be checked by producing a test print. 

Highlight the file to test in the Project Contents window and either
click on the Test Print button in the toolbar or select Run/Test
Selected Files from the Menu bar.

If BiDi is enabled a message should appear briefly in the BiDi box
saying ‘NVM Open’, and the selected file will then be printed.
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4.6.3 Downloading to Network Printers
When a Project is to be used on multiple printers, do the following:

● Select File/Open Project and select a project.
● Select Run/Batch printing and select the printers to be 

updated. Make sure that those which are not to be updated are 
deselected.

4.6.4 Status Page
To check that the download has been successful, print a status page
by clicking on the Status Page button in the toolbar or selecting
Documentation/status page from the Options menu. A status
page will be printed showing a list of macros and fonts stored in the
NVM, together with a report of used and available memory.

4.7 General Updates
This feature allows the deletion of macros, forms, fonts or signatures
in the NVM.
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Once the Project has been downloaded to the NVM, it must be
checked to ensure the fonts and macros can be accessed. To make
fonts available it will be necessary to add them to the printer set-up.

5.1 Making Fonts available to Windows
In order to be able to use the fonts stored in the NVM from Windows
applications, they must be defined in the Windows Printer Setup. 

To set up the fonts for Windows, do the following:

● From Control Panel, select Printers and select the printer 
● Select Printer Set-up 
● Select Fonts and click on Add/Delete font. Select Add Fonts 
● Select the drive and directory containing the Fonts Driver File 

(when the software was installed this was set to C:\PCLFONT). 
Available Projects containing fonts will be displayed

● Select the required Project(s) and click on the Add button
● A prompt will ask for for the destination directory (default is 

C:\PCLFONT)
● Select OK and the selected Projects will be displayed 

in the Printer Window
● Select Exit to return to the Setup dialog. The installed Projects 

will appear in the list of Cartridges/ SIMMS. Highlight those 
containing fonts to be used. (LaserJet 5SI: This step does not apply).

● Select OK to enable the font selection and exit Printer Setup 

For Windows 95, do the following:

● From the  Start menu, select Settings/Printers. The Printers 
dialog box will appear.

● Highlight the printer to be used by clicking on it and then select 
File/Properties from the menu.

● Click on the Fonts tab in the dialog box that appears.
● Choose either Download Fonts or run HP Font Smart and follow 

the instructions to select the fonts required.

The fonts are now available to all Windows applications and will
appear on font lists.

5. Accessing Stored Fonts and Macros
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5.2 Calling Fonts and Macros from Applications

5.2.1 Fonts
Fonts which have been downloaded to the NVM and installed in
Windows (See Section 4) will appear in the font selection list boxes in
applications.

5.2.2 Macros
In order to access Macros in the NVM, either the FlashPM™ utility
can be used or an Escape Sequence can be inserted into the
document. Consult the application documentation for instructions on
how to insert Escape Sequences.

The FlashPM™ utility is included with the HP Forms and Font
Manager and will have been installed automatically. To activate it,
click on the FlashPM™ icon in the Windows Program Manager Flash
SIMM group. Instructions on how to use the utility can be found by
clicking on Help once the program has loaded.

The Escape character which begins an Escape Sequence, is a special
character which cannot be typed directly from the keyboard and most
applications have a special method for inserting it. Consult the
application manual for instructions on how to insert the Escape
character and then follow the steps below:

● Move the cursor to the point in the document where the Macro is
to be inserted

● Type: ESC&f####y3X (Where ESC is the accepted method of 
entering an Escape Character and #### is the Macro ID). It is 
important to type lower case 'f' and 'y' and a capital 'X'.

As an example, to insert an Escape Sequence in a Microsoft Word for
Windows Version 6.0 or 7.0 document, do the following:

● Select the Insert menu from the menu bar. Select Field
● Scroll down the Field Names box and select Print
● In the Field Codes box below, the word PRINT appears. Type 

in the escape sequence between quotes but without the escape 
character after the word PRINT e.g.  “&f123y3X”

● Click on OK
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● From the Tools menu in the menu bar, select Options
● In the View screen, click on Field Codes check box

to activate it. Click on OK.
● The Field Code is now displayed in the document. Position the 

cursor after the opening quote and before the ‘&’ and insert the 
escape character by holding down the ALT key and typing 027
from the numeric keypad. It will be displayed as a box character.
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This section gives a brief explanation of the Job Commands in the
HP Forms and Font Manager Advanced Options Menu. For a full
explanation of PCL commands, consult the PCL 5 Printer Language
Technical Reference Manual (Part No. 5961-0509).

Call Macro ID
Calls the macro whose identification number is specified. When a
macro is called the current print environment is saved before the
commands in the macro are carried out, and restored once the macro
has completed. 

Execute Macro ID
When a macro is executed, any changes which are made to the print
environment remain in force once the macro has completed.

Form Feed
Causes the printer to eject a sheet of paper.

Papersize
Specifies the size of paper the printer is using.

Output Bin Selection
On printers which have more than one paper collection bin, selects
output bin.

Papertray
On printers which have more than one input paper tray, selects the
paper tray from which paper will be fed into the printer.

Orientation
Selects whether the job should print in portrait or landscape mode.

Simplex/Duplex
On printers that have duplex printing capabilities, selects whether to
print on one or on both sides of the paper.

6. PCL Commands
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Job Separation
Some printers are able to separate one print job from the next by
offsetting the sheets of paper in the output tray. This command
causes the printer to offset a print job in the output tray.

Copies
Specifies the number of copies required.

Escape Sequence
This command inserts the Escape character and takes whatever
parameter is supplied. The HP LaserJet Printer User's manual has a
useful section on Printer Commands.



BiDi
BiDi is a facility which allows two-way communications between a
computer and a printer.

If the printer is connected directly to the parallel port of a PC, the
parallel ports must be capable of supporting nibble mode as defined
in IEEE 1284.

If the printer is connected to a PC by a network, the Network
Operating System must conform to the Windows Sockets
specification.

HP Forms and Font Manager is capable of operating with any
Windows Sockets Compliant protocol implementation. HP Forms and
Font Manager has a Windows Sockets Interface and is a Windows
Sockets Application.

Font
A font is a complete set of characters of a given size and style. A font
is identified by three elements; the type face (such as Times Roman
or Courier), the type style (such as Bold or Italic) and the type size
(such as 12pt). For example: 

Times Roman Bold 10pt

Courier Italic 14pt

The HP Forms and Font Manager supports PCL Bitmap Fonts,
Intellifont Scaleable Fonts, TrueType fonts and user-defined Symbol
Sets if these facilities are available in the printer.

Font Drivers
The Drivers sub-menu allows the creation of drivers for fonts
included in the Project. These drivers will be used to make the fonts
available to application programs. 

7. Glossary
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Macro
A macro is a group of printer commands and/or data which is
downloaded for storage in the NVM.

Macros can be created using popular Word Processing/Forms Design
software packages or from within the HP Forms and Font Manager
program. Each macro is assigned a unique ID number (any number
between 1 and 32767, excluding the range 31000 to 31400).

Once stored in the NVM, a macro can be called from within an
application using the assigned macro ID number. 

Practical uses of macros include forms such as invoices and purchase
orders, standard letters, letterheads, logos and lengthy printer
commands.

Further information on macros, PJL and HP PCL can be found in the
Hewlett-Packard Technical Reference Documentation Package (Part
No. 5961-0601).

Non-Volatile Memory (NVM)
Non-volatile memory is a term used to describe memory which
retains its contents even when the power is switched off. In the
context of this manual, this means HP Flash SIMM or HP hard disk
options installed in an HP LaserJet printer.

Password Protection
Password protection prevents accidental or unauthorised
modification or deletion of macros and/or fonts stored in the NVM.

Projects
One or more files (macros and/or fonts) grouped together. The details
of the components of the Project are stored in a Project control file
that is created when the Project is saved. Project control files are
given the file extension .PRJ as a default and are held in the project
directory.



45

8.1 Working with Bitmaps
This assumes that a company logo is available as a Windows Bitmap.
Use a graphics application to print the image to a file.

● From the Windows Control Panel, select the printers icon. A 
list of printers connected to the computer will be displayed. 

● Select the printer to print to and click on the Connect button. A
new dialog box will open with a list of ports to which the printer 
can be connected. Scroll down until you see FILE: and select it, 
then click on OK. 

● Close the printers dialog box and then close Control Panel. 
● Now print the image of the company logo. A prompt box will 

appear asking for a filename for the print file. Enter the 
complete path, for example, c:\flash\data\logo.prn

● From the HP Forms and Font Manager main screen, select the 
print file from the Directory Contents box on the left and 
double-click to copy it into the Project Contents box. Enter 
a macro ID number in the ID column. 

● Save the project by clicking on the Save Project icon in the 
tool bar or by selecting File/Save as... from the menu bar. Give 
the project a name and description, if required, then click OK.

● Download the project to the printer by clicking on the 
Download to the Printer button and selecting the printer as 
the Output to option. The HP Forms and Font Manager will 
download the data. 

● Do a test print by clicking on the Test Selected Files button in 
the tool bar.
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8.2 Working with Fonts

● From the HP Forms and Font Manager software main screen, 
select Files/ New project.

● Select Options/Environment.
● In the Directory Contents window, double-click on a font file

to move it to the Project Contents window.
● Enter the Font ID in the ID column.
● Save the project by clicking on the Save Project icon in the 

tool bar or by selecting File/Save as... from the menu bar. Give 
the project a name and description, if required, then click OK.

● Select Run/Download to the Printer then select the printer 
NVM option from the dialog box. HP Forms and Font Manager 
will download the project to the printer.

● Select Options/Driver.
● Font drivers will be created and placed in C:\PCLFONT (for 

Windows) and in C:\AUTOFONT (for DOS applications).
● To test the Font, highlight it in the Project Window and select 

the Test Macro button. A font sample will print on the default 
printer.

● Now install the font driver into Windows (See Section 5).

8.3 Converting Bitmaps to Fonts

● Scan a signature or other graphic and save it as a file, for 
example, c:\flash\data\sign.bmp.

● From the HP Forms and Font Manager main screen, select the 
bitmap file of the signature from the Directory Contents box. 
If the file is not shown, use the folder button under the list box
to choose the drive and directory to which the file was saved. 

● Highlight the file and double-click to copy it over into the 
Project Contents window. Enter an ID number in the ID column. 

● Select Options/Project Defaults. 
● Select the Bitmap tab and check the To Font option.
● Click on the Font tab. Enter a typeface number, a symbol set 

selection code (use 15Q which is the Roman8 symbol set), and a 
name for the font.

● Enter the character to be typed whenever your signature is  to be 
printed. The ID number below is the Font ID number which was 
assigned to this file in the Project Contents window. Click on OK. 
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● Save the project by clicking on the Save Project icon in the 
tool bar or by selecting File/Save as... from the menu bar. Give 
the project a name and description, if required, then click OK.

● Select Run/Download to the Printer then select the printer 
NVM option from the dialog box. HP Forms and Font Manager 
will download the project to the printer.

● Select Options/Driver.
● Font drivers will be created and placed in C:\PCLFONT (for 

Windows) and in C:\AUTOFONT (for DOS applications).
● Do a test print by clicking on the Test Macro button in the 

toolbar.
● Now install the font driver into Windows (See Section 5).
● To print your signature in a word-processing document type the 

chosen character, highlight it, apply the font name to it, and 
print the document.

8.4  Complex Jobs
By using appropriate Job Commands to control a series of macros it
is possible to automate the printing of complex documents. In this
example the document is a duplicate sales invoice bearing the Terms
and Conditions of trade on the reverse of the original and the word
COPY on the duplicate. This example assumes that the output
printer is capable of duplex printing and has two paper trays.

● Using a word processor or Forms Design software, prepare a 
blank invoice (portrait format) and print to a file called 
INVBLANK.PRN. (See Section 8.1 above).

● Using a word processor prepare the Terms and Conditions to 
appear on the reverse of the invoice and print to a file called 
T&C.PRN.

● Using a graphics program or a word processor prepare the 
“COPY” text. Select a large font size and an outline typeface and 
position the word “COPY” in the middle of the page. Print to a 
file called COPYTXT.PRN.

● From the HP Forms and Font Manager software main screen, 
select Files/ New project.

● Highlight the three files INVBLANK.PRN, T&C.PRN and 
COPYTXT.PRN in the Directory Contents box and double-
click to copy them into the Project Contents box.
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● Assign macro ID 1 to INVLBLANK.PRN, 2 to T&C.PRN and 3 
to COPYTXT.PRN

● Click on the red A to the right of the COPYTEXT.PRN file, then 
click on the Job Commands tab.

● From the list of Available Commands double click on 
Simplex/Duplex and type ‘1’ in the prompt box. The command 
is copied into the upper window.

● From Available Commands select Papertray and type 1 in 
the prompt box to select the main papertray.

● From Available Commands select Call Macro ID, and enter 4
in the prompt box. (This ID will be for the invoice data). The 
command is copied to the upper window. 

● From Available Commands select Call Macro ID, and enter 1
in the prompt box. (This is INVBLANK.PRN). The command is 
copied to the upper window. 

● From Available Commands select <FF>. (This will eject the 
page with the invoice form and invoice data printed on the 
front).

● From Available Commands select Call Macro ID, and enter 2
in the prompt box. (This is T&C.PRN). The command is copied to
the upper window. 

● From Available Commands select <FF>. (This will eject the 
page with the invoice form and data printed on the front and the
terms and conditions on the back).

● From the list of Available Commands double click on 
Simplex/Duplex, choosing Simplex when the prompt box 
appears. The command is copied into the upper window.

● From Available Commands select Papertray and type 5 in 
the prompt box to select the secondary papertray. (This tray can 
be filled with coloured paper).

● From Available Commands select Call Macro ID, and enter 4
in the prompt box. (This is the invoice data for the copy invoice). 
The command is copied to the upper window. 

● From Available Commands select Call Macro ID, and enter 1
in the prompt box. (This is INVBLANK.PRN). The command is 
copied to the upper window. 

● The last entry in the top window is Current Macro, which is the 
COPY text to be overprinted on the copy invoice

● Click on OK. Save the project
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● Click on the printer button in the toolbar to download the 
project to the printer.
● To do a test print, highlight the COPYTXT.PRN macro in the 

project window and click on the test print button in the toolbar.
The test should produce a blank invoice with the Terms and 
Conditions text printed on the back and another blank invoice 
with COPY overprinted.

● In your invoicing application enter the following escape sequence
at the beginning of the invoice: <esc>&f4y0X
This starts recording the macro that contains the data for this 
invoice. Then enter the invoice data. At the end of the data enter
the following escape sequence: <esc>&f1x9x3y3X
This will call the COPYTXT macro which will call the others in 
sequence.
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